
VYSOKÉ UČENÍ TECHNICKÉ V BRNĚ

Fakulta elektrotechniky
a komunikačních technologií

BAKALÁŘSKÁ PRÁCE

Brno, 2016 Jakub Cekl



VYSOKÉ UČENÍ TECHNICKÉ V BRNĚ
BRNO UNIVERSITY OF TECHNOLOGY

FAKULTA ELEKTROTECHNIKY
A KOMUNIKAČNÍCH TECHNOLOGIÍ
FACULTY OF ELECTRICAL ENGINEERING AND COMMUNICATION

ÚSTAV ELEKTROENERGETIKY
DEPARTMENT OF ELECTRICAL POWER ENGINEERING

TESTOVÁNÍ FUNKCE SYNCHRO-CHECK VÝVODOVÉ
OCHRANY
TESTING OF SYNCHRO-CHECK FUNCTION OF FEEDER PROTECTION TERMINAL

BAKALÁŘSKÁ PRÁCE
BACHELOR'S THESIS

AUTOR PRÁCE
AUTHOR

Jakub Cekl

VEDOUCÍ PRÁCE
SUPERVISOR

doc. Ing. Jaroslava Orságová, Ph.D.

BRNO 2016



Fakulta elektrotechniky a komunikačních technologií, Vysoké učení technické v Brně / Technická 3058/10 / 616 00 / Brno

Bakalářská práce
bakalářský studijní obor Silnoproudá elektrotechnika a elektroenergetika

Ústav elektroenergetiky
Student: Jakub Cekl ID: 158111
Ročník: 3 Akademický rok: 2015/16

NÁZEV TÉMATU:

Testování funkce synchro-check vývodové ochrany

POKYNY PRO VYPRACOVÁNÍ:

1.  Nastavení  a  testování  funkce  pro  synchronní  spínání  v  síti  (synchro-check)  testeru  elektrických  ochran
OMICRON 256+.
2. Zpracování manuálu pro testování včetně výstupního protokolu.
3. Příprava praktické aplikace synchro-checku pro fázování laboratorního generátorového soustrojí.

DOPORUČENÁ LITERATURA:

podle pokynů vedoucího práce

Termín zadání: 8.2.2016 Termín odevzdání: 24.5.2016

Vedoucí práce:     doc. Ing. Jaroslava Orságová, Ph.D.
Konzultant bakalářské práce:     

doc. Ing. Petr Toman, Ph.D., předseda oborové rady

UPOZORNĚNÍ:
Autor bakalářské práce nesmí při vytváření bakalářské práce porušit autorská práva třetích osob, zejména nesmí zasahovat nedovoleným
způsobem do cizích autorských práv osobnostních a musí si být plně vědom následků porušení ustanovení § 11 a následujících autorského
zákona č. 121/2000 Sb., včetně možných trestněprávních důsledků vyplývajících z ustanovení části druhé, hlavy VI. díl 4 Trestního zákoníku
č.40/2009 Sb.



ABSTRAKT
Práce se věnuje testování automatického fázování za pomoci terminálu točivého stroje
REM 545 firmy ABB a jeho funkce synchro-check zkušebním přístrojem CMC 256+
firmy OMICRON, kterým jsou simulovány parametry sítě a alternátoru. Nejprve jsou
nastíněny základní principy fázování a jejich podmínky. V následujících kapitolách je
popsáno vytvoření konfigurace, příprava testovacího přístroje a provedení testu. Závěrem
je vytvořen návrh testu v reálném provozu.
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ABSTRACT
This thesis is oriented on testing of automatic synchronizing with the help of the machine
terminal REM 545 by ABB and its synchro-check function by CMC 256+ tester by
OMICRON, where network and alternator parameters are simulated. Basic principles of
phasing and phasing conditions are briefly mentioned. Creation of configuration, tester
preparing and test execution are described in following chapters. Test of real use is
suggested at the end.
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1 SYNCHRONIZACE
Synchronizací je myšlen paralelní chod zařízení a sítě při jejich vzájemném propojení.
Pro výrobu jsou nejvíce využívány synchronní alternátory. Výjimku tvoří výrobny
velmi malých výkonů, které mohou využívat asynchronní generátory. Synchronní
alternátory mohou pracovat do dvou typů sítí. Prvním z nich napájení vlastní sítě.
Alternátor je rozeběhnut poháněcím strojem přibližně na synchronní otáčky. Je za-
pojeno buzení a doregulováno napětí na svorkách stroje. Alternátor je připojen do
sítě, čímž začne být zatěžován. Přívod energie pro pohánění alternátoru se řídí podle
zatížení. Druhým možným způsobem jsou alternátory pracující do společné sítě. Spo-
lečnou sítí je myšlena síť, kterou již napájí jiné zdroje elektrické energie. Zde je nutné
zajistit splnění podmínek paralelního chodu před jeho připojením. Mluví se o tzv.
fázování.

1.1 Asynchronní fázování
Asynchronní fázování, též zvané samosynchronizace, je postup připojení alternátoru
do sítě za doprovodu nárazů jalového proudu. Proto se používá jen v havarijních situ-
acích nebo u zdrojů malých výkonů. Poháněcím strojem se roztočí rotor alternátoru
do téměř synchronních otáček, připojí se do sítě a nabudí. Alternátor se následně
sám vtáhne do synchronismu pomocí synchronizačního momentu. V okamžiku při-
nutí do sítě, musí být zkratováno budící vinutí, aby nedošlo ke vzniku nebezpečného
napětí na kroužcích alternátoru. V menších soustavách může v blízkosti připojeného
alternátoru dojít k poklesu napětí, jako důsledek proudových a momentových rázů.

1.2 Přesné fázování
Připojení alternátoru do společné sítě, kdy nedochází k proudovým ani momentovým
nárazům, je nazýváno přesné fázování. U tohoto způsobu fázování se musí splnit hned
několik podmínek, kterými jsou:

• Stejný sled fází alternátoru a sítě
• Stejná velikost napětí alternátoru a sítě
• Stejné kmitočty napětí alternátoru a sítě
• Nulový fázový posun mezi fázory napětí alternátoru a sítě

Přesné dodržení všech těchto podmínek by však v mnoha případech reálného
provozu, znamenalo výrazné prodloužení fázovacího procesu. Z tohoto důvodu jsou
povoleny určité odchylky. Tím je sice dovolen vznik proudových a momentových
rázů, ty jsou však tak malé, že nemají výrazné negativní účinky.
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Stejná fáze napětí, je při připojování alternátoru do sítě, nejdůležitější. Nedodr-
žením této podmínky vzniká částečný zkrat, jehož velikost proudu se rovná rozdílu
okamžitých hodnot alternátoru a sítě. Proto je potřebné připojit alternátor do sítě
v okamžiku nulového rozdílu napětí a obou prvcích. V nejhorším případě, pokud by
byla obě napětí v protifázi, tedy při vzájemném posunutí o úhel 𝜋, mohou vzniknout
nárazové proudy vysokých hodnot. Ty jsou v nejnepříznivějším případě dvojnásobně
větší než zkratové proudy, na které je alternátor dimenzován a mohlo by tedy dojít
k jeho poškození. Dovolené odchylky mezi fázemi obou napětí jsou podle [1] do 8 -
12°.

Stejný sled fází má význam zejména během uvádění do provozu jak nových al-
ternátorů, tak alternátorů, které prošly opravou. Následkem rozdílného sledu fází,
by v okamžiku připojení, byl vznik těžkého zkratu, jehož silové účinky jsou velmi
nebezpečné pro alternátor i hnací stroj. Správnost sledu fází je zjišťována synchro-
noskopem.

 
Im 
 
 
 
       Ū    
           Re 
 

      Ūs  j∙i0"(xd"+xv) 
 
i0" 

Obr. 1.1: Fázorový diagram - charakter proudového rázu

Velikosti napětí alternátoru a sítě také dovolují jisté odchylky. Z fázorového dia-
gramu na Obr. 1.1 lze vyvodit čistě jalový charakter vzniklého proudového nárazu.
Při vyšším napětí na straně alternátoru půjde o náraz induktivního zatížení. U vyš-
šího napětí na síti pak půjde o náraz kapacitního zatížení. Praktické fázování dovo-
luje odchylku napětí až 5 %, v poruchových stavech i 20 %. Vyšší napětí je žádoucí
na straně alternátoru, který po připojení k síti začne pracovat jako generátor a ihned
dodává jalový výkon do sítě. V opačném případě by začal pracovat jako motor.
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Dojde-li k zapnutí alternátoru k síti při nulové odchylce napětí i nulové chybě
fáze, avšak při rozdílu kmitočtů, alternátor se nemusí udržet v synchronismu. Při
vyšším kmitočtu alternátoru, se bude po připojení na síť otáčet rotor alternátoru,
vlivem setrvačnosti, rychleji než rotory ostatních strojů v síti. Roztáčecí soustrojí má
pak přebytek kinetické energie. Pokud se rotor alternátoru neotáčí výrazně rychleji,
je tento přebytek využit ke zpomalení na synchronní otáčky. Při vyšších rychlostech
otáčení, kdy je i kinetická energie větší, dojde ke zpomalení do synchronismu až po
několika otáčkách, během kterých točivé momenty působící na alternátor dosahují
nebezpečných hodnot. Z tohoto důvodu je povolena odchylka kmitočtu o pouhých
0,1 %.

Pro kontrolu splnění fázovacích podmínek lze využít hned několika způsobů,
které jsou popsány v následující podkapitole.

1.2.1 Fázování na tmu

Tento způsob je již zastaralý a dnes používá zejména ve školních laboratořích pro vy-
světlení principu fázování. Je též relativně nepřesný, protože závisí na reakci obsluhy.
Provedení je však velmi jednoduché. K signalizaci správného okamžiku zapnutí jsou
využity žárovky zapojené na stejných fázích alternátoru i sítě. Liší-li se kmitočty
alternátoru a sítě málo, rozdíl jejich napětí lze zobrazit periodickou čarou kmita-
jící interferenčním kmitočtem jak je znázorněno na Obr. 1.2. Ten je dán rozdílem
kmitočtů alternátoru a sítě. Frekvence sítě je pro žárovku příliš vysoká a ta se tedy
nestačí rozsvěcovat a zhasínat. Dokáže však sledovat interferenční kmitočet. Zhas-
nutí všech žárovek ve stejný okamžik indikuje stejnou okamžitou hodnotu napětí
sítě i alternátoru a tedy vhodný okamžik k připojení do sítě bez doprovodu prou-
dového nárazu. Použití tří žárovek pro indikaci správného okamžiku zapnutí není
nutné a postačila by pouze jedna. Používají se však z důvodu kontroly správného
sledu fází. Místo žárovek lze využít analogových voltmetrů, kde k sepnutí dochází
při nulových výchylkách ukazatelů.

Obr. 1.2: Interferenční kmitočet fázování [3]
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1.2.2 Fázování pomocí synchronoskopu

Synchronoskop je přístroj, jehož ukazatel se udává vzájemný posuv vektorů napětí.
Rychlost otáčení je dána velikostí úhlu mezi stejnými fázemi. Podle směru otáčení
lze zjistit, jestli je větší frekvence na straně sítě či alternátoru. Okamžik vhodný pro
připojení do sítě je naznačen na stupnici synchronoskopu. Příklad synchronoskopu
je vidět na Obr. 1.3.

Obr. 1.3: Příklad analogového synchronoskopu

1.2.3 Samočinné fázovací automaty

Jejich účelem je rychlé, samočinné propojení alternátoru a sítě. Mají jisté zpoždění,
proto musí dojít k příkazu připojení na síť s lehkým předstihem, který bývá předem
nastaven. Samočinné fázovací automaty, někdy také fázovače, měří a porovnávají
všechny důležité veličiny a pomocí vyhodnocovacího programu samy určí vhodný
okamžik sepnutí.
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2 CÍLE PRÁCE
Cílem práce je vytvoření konfigurace terminálu točivých strojů REM 543 od firmy
ABB a otestování funkce synchro-check. Konfigurace bude vytvořena v programu
CAP 505 pomocí funkčních bloků a jejich nastavením. Následně bude funkčnost na-
stavení funkce synchro-check otestována testerem elektrických ochran CMC 256+
od firmy OMICRON a to pomocí pokročilé funkce Synchronizer. Po ověření správné
funkčnosti konfigurace bude provedena příprava pro otestování na laboratorním
zdroji.

13



3 TERMINÁL TOČIVÉHO STROJE REM 545
Podle uživatelské příručky [5] se terminály točivých strojů REM 545 od firmy ABB
(Obr. 3.1) používají pro chránění, měření, ovládání a monitorování točivých strojů
pro výrobu elektrické energie. Funkčnost terminálů je závislá na použité knihovně
specifických funkcí. Při použití knihovny, která umožňuje kontrolu synchronního
i napěťového stavu (Synchrocheck/Voltagecheck), lze terminál zařadit mezi samo-
činné fázovací automaty.

Obr. 3.1: Terminál točivého stroje REM 545

3.1 Funkce Synchro-check
Použitím této funkce je docíleno plně automatického připojování synchronních al-
ternátorů k síti. Funkci synchro-check je možné provozovat ve dvou módech. Prvním
z nich je CONTINUOUS mode, u kterého je synchronní stav kontrolován nepřetr-
žitě a v okamžiku splnění nastavených podmínek je vyslán povel externímu zařízení
k přifázování. Druhým je COMMAND mode, u kterého je uživatelem podán povel
k přifázování a následně je kontrolován synchronní stav po jehož splnění je provedeno
přifázování.

Synchro-check je používán ve dvou případech. První, méně častý z nich, je připo-
jení dvou sítí, kdy je napětí pouze na jedné nebo žádné straně výkonového vypínače.
V tomto případě není možné měřit rozdíly veličin a je tedy pouze vyhodnocováno,
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která síť je pod napětím. Druhým případem je přítomnost napětí na obou stranách
výkonového vypínače. Funkce sleduje splnění synchronizačních podmínek, tedy oka-
mžik, kdy jsou napěťová, frekvenční i fázová podmínka splněny a na jejich základě
je kontrolováno trvání synchronismu. Ten musí trvat dostatečně dlouho aby bylo
zajištěno jeho splnění i v okamžiku sepnutí. To proto, že zpoždění výkonového vy-
pínače a ovládacího systému je oproti signálu terminálu, podle [4], v rozsahu 50 až
250 ms. Z tohoto důvodu je také možné nastavení minimální doby, po kterou musí
být podmínky pro synchronizaci splněny. Sepnutí je též možné ve dvou módech.
Asynchronní mód fázuje jsou-li fázory napětí v toleranci, která je nastavená. Syn-
chronní mód výpočtem stanový čas kdy bude nulový fázový posun fázorů napětí a
pošle signál k sepnutí. Ten je vyslán v předstihu, který je rovný pracovnímu času
výkonového vypínače.
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4 OMICRON CMC 256+
CMC 256+ firmy Omicron je zkušební přístroj, používaný pro zkoušky zařízení,
jakými jsou například ochrany, měřící převodníky a elektroměry. "CMC 256+ je
součástí OMICRON Test Universe, který se vedle zkušebního přístroje samotného
skládá z PC, softwaru a, pokud je to potřebné, vnějších zesilovačů" [6]. Softwarem
OMICRON Test Universe se provádí samotná konfigurace a nastavování přístroje.
Hlavními funkcemi přístroje CMC 256+ je vytvoření zkušebních signálů ve formě
proudů, napětí nebo binárních signálů. Další funkcí je analogově a binárně měřit
reakce zkoušeného objektu a, je-li potřeba, zajistit jeho napájení. Na Obr. 4.1 je
vyobrazen přední panel přístroje i s popisem jednotlivých konektorů. Zadní panel
pak obsahuje převážně ventilační otvory, napájecí konektor, pojistku, datový port
pro komunikaci s PC a tlačítko Associate pro spárování přístroje s PC.

Obr. 4.1: Čelní panel přístroje CMC 256+ s popisem svorek [6]
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4.1 Synchronizer
Synchronizer je samostatným programem v rámci programového celku OMICRON
Test Universe. Zaměřuje se na testování synchronizace. Pomocí tohoto programu lze
nasimulovat parametry sítě (systém 1) i alternátoru (systém 2), které jsou poslány
do terminálu točivého stroje. Příkaz k vybavení vypínače je přijat pomocí binárního
vstupu. Signál z binárního vstupu je pak využit k vyhodnocení. Nastavování tes-
tovacích bodů se prování ručním přidáním bodu nebo zadáním hodnot, které jsou
následně zobrazeny jako body v Synchronizačním okně, jak ukazuje Obr. 4.2. Ohra-
ničení je dáno nastavenými tolerancemi. Svislá osa udává rozdíly napětí, vodorovná
pak rozdíly ve frekvenci. Rozdíl úhlu fázového posunu lze nastavit pouze ručně.

Obr. 4.2: Příklad rozložení bodů v synchronizačním okně modulu Synchronizer

4.1.1 Test funkčnosti

Synchronizer může být použit dvěma způsoby. Prvním z nich je test funkčnosti.
Ten má za úkol prověřit správnou funkčnost ochrany podle nastavených podmínek.
Synchzonizer pak porovnává, zdali došlo či nedošlo k připojení na síť s ohledem na
nastavené parametry sítě a alternátoru a s ohledem na nastavené tolerance. Výsle-
dek tohoto porovnání je následně zobrazen v programu jako splnění či nesplnění
předpokládaného stavu. Mohou být zkoušena jednotlivá nastavení nebo může být
vytvořena tabulka testovaných bodů, které se následně otestují bez nutnosti zásahu
obsluhy. U testovacích bodů uvnitř ohraničení, kdy odchylky nepřesahují tolerance,
Synchronizer předpokládá, že k sepnutí výkonového vypínače dojde během nasta-
veného času trvání synchronizace. Leží-li body vně, je předpokládáno, že se signál
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k sepnutí během tohoto času neobjeví, tedy že nedojde k připnutí do sítě. Čárkova-
nou čarou je nastavena oblast nejasného výsledku. V této oblasti tedy může dojít
k sepnutí ve vymezeném čase nebo nemusí.

4.1.2 Test kompenzace

Druhým způsobem použití je test kompenzace. Zde jsou definovány povely pro regu-
laci, které řídí napětí a frekvenci a jsou vydávány synchronizačním relé ke generátoru.
Opět lze použít jednotlivé body nebo tabulku testovaných bodů. Synchronizační
okno je znovu nastaveno pomocí tolerancí napětí a frekvence. Leží-li testovací bod
mimo Synchronizační okno a relé obdrží spouštěcí povel, vyšle relé příslušný signál
(V>, V<, f>, f<), aby mohl být generátor připojen do sítě. Synchronizer tento bi-
nární signál detekuje a upraví napěťový výstup systému 2. Synchronizační relé by
mělo vyslat řídící signál až po vstupu systému 2 do synchronizačního okna. Vstoupí-
li systém 2 do synchronizačního okna během nastaveného synchronizačního času,
výkonový vypínač může sepnout. V opačném případě Synchronizer vyšle ukončovací
povel.
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5 KONFIGURACE POMOCÍ CAP 505
Komunikace mezi PC a terminálem REM 545 obstarává kabel COM. Základní ob-
razovka, která se zobrazí po spuštění programu CAP 505 je znázorněna na Obr. 5.1.

Obr. 5.1: Základní obrazovka programu CAP 505

Zde kliknutím na červeně označenou ikonu otevřeme okno General Object Attri-
butes (Obr. 5.2), které slouží k nastavení komunikace.

V záložce Cummunication zvolíme protokol SPA, jako sériový port COM1 a hod-
notu SPA adresy zvolíme 4. Okno General Objech Attributes můžeme zavřít tlačít-
kem OK pro uložení nastavení.

Obr. 5.2: Nastavení komunikace terminálu

Na základní obrazovce nejprve v levé části vybereme položku REM 545, následně
se nám v pravé části zobrazí několik možností. Zde vybereme položku Relay Down-
load Tool. Položka Realy Download Tool slouží pro stažení aktuální konfigurace
z terminálu nebo k nahrání konfigurace nové.

V nově otevřeném okně (Obr. 5.3) přejdeme do záložky Recieve, zaškrtneme
možnosti Mimic Configuration a RCT Project a potvrdíme klepnutím na tlačítko
Recieve. Následně proběhne stažení aktuální konfigurace z terminálu. Tento krok
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provádíme z toho důvodu, že využijeme funkční konfiguraci, do které pouze přidáme
funkci synchro-checku. Máme tedy jistotu správné funkčnosti výkonového vypínače.
Okno zavřeme klepnutím na tlačítko Store, čímž se uloží obsah právě stažené kon-
figurace do paměti PC pro budoucí použití, bez nutnosti opětovného stažení.

Obr. 5.3: Stažení konfigurace z terminálu

5.1 Relay Configuration Tool

Obr. 5.4: Stromová struktura konfigurace - Relay Configuration Tool

Ze základní obrazovky přejdeme do položky Relay Configuration Tool, kde do
stávající konfigurace budeme přidávat funkční bloky synchro-checku. Okno Relay
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Obr. 5.5: Insert Logical POU

Obr. 5.6: Parametry pro Task T10

Configuration Tool obsahuje stromovou strukturu konfigurace. Detail výsledné stro-
mové struktury je znázorněn na Obr. 5.4. Při vstupu do Relay Configuration Tool
zadáme heslo "abb".

Označíme položku Logical POUs, z řádku nabídek přejdeme do sekce Edit, kde
vybereme Insert. V okně, které se objeví (Obr. 5.5), vyplníme název funkce jako
PROTECT, v poli Type vybereme Program a v poli Language FBD. Zbylé necháme
beze změny a potvrdíme tlačítkem OK.

Stejný postup opakujeme u položky Tasks. V nově otevřeném okně do pole Name
zadáme T10 a do výběrového menu Task type vybereme CYCLIC. Kliknutím na
tlačítko Settings se nám otevře okno pro nastavení Tasku, jak je znázorněno na
Obr. 5.6. Zde nastavíme interval trvání na 10.0000 ms. Obě okna zavřeme potvrzením
pomocí tlačítka OK.

Ve stromové struktuře označíme T10 a v sekci Edit řádku nabídek vybereme
Insert. Otevře se okno Properties (Obr. 5.7). V poly Type vybereme Program a do
kolonky Program instance napíšeme PROTECT. Ve výběrovém menu vybereme
také PROTECT. Potvrdíme tlačítkem OK.
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Ve stromové struktuře označíme položku REM 545, z řádku nabídek vybereme
File a následně Edit Object Properties. Objeví se nám okno Configuration of REM
545 znázorněné na Obr. 5.8.

Obr. 5.7: Program pro task T10

Obr. 5.8: Konfigurace analogových kanálů terminálu REM 545

V sekci Analog Channels nastavíme Signal Type u kanálu Channel 5 na U12 a pro
Channel 6 na U12b. U obou kanálů je nutné další nastavení. Vybereme Channel
5 a stiskneme Measurements. Objeví se nám okno Special Measurements jak je
znázorněno na Obr. 5.9. Zde zaškrtneme kolonku Frequency Protection a potvrdíme
stiskem OK. Opakujeme i pro druhý kanál.

Poklepáním na položku PROTECT se nám otevře okno GRAPHIC pro vkládání
funkčních bloků. Kliknutím označíme místo pro vložení funkčního bloku (po klepnutí
se objeví černý křížek). Ikony tohoto prostředí jsou znázorněny na Obr. 5.10 Klep-
neme na tlačítko Add Function Block. To nám otevře okno Function/Function Block
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Obr. 5.9: Nastavení frekvenční ochrany pro napěťové vstupy

znázorněné na (Obr. 5.11). Ve výběrovém menu položky Name vybereme SCVCSt1,
reprezentující funkční blok synchro-checku, a potvrdíme stiskem OK.

Obr. 5.10: Ovládací tlačítka v prostředí GRAPHICS

Klikneme na tlačítko Add Variable a přidáme signál U12
Dále přidáme signály U12b a BIO_5_SO1.
Signály propojíme s blokem synchro-checku tak, jak je znázorněno na Obr. 5.12.

Dokončíme úpravy tlačítkem Kompilovat list. Celou konfiguraci uložíme tlačítkem
Kompilovat vše. Okno Relay Configuration Tool můžeme nyní zavřít.

Konfiguraci nahrajeme do terminálu přes položku Relay Download Tool. V zá-
ložce Send zaškrtneme kolonky Relay Configuration a RCT Project. Ujistíme se, že
je též zaškrtnutá položka Store + Reset after download, která zajistí uložení konfi-
gurace do paměti terminálu, jak je znázorněno na Obr. 5.13. V opačném případě by
po odpojení terminálu od napájení došlo ke ztrátě námi nahrané konfigurace.
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Obr. 5.11: Vložení funkčního bloku synchro-checku

Obr. 5.12: Zapojení signálů na blok synchro-checku

Obr. 5.13: Odeslání konfigurace do terminálu
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5.2 Relay Settings Tool
Ze základní obrazovky přejdeme do položky Relay Settings Tool, která slouží pro
nastavení námi vytvořené konfigurace. Přejdeme do záložky Protection a v záložce
SCVCSt1 otevřeme Setting group1. Zde nastavíme maximální a minimální násobky
jmenovitého něpětí na 𝑈𝑚𝑎𝑥 rovno 1 a 𝑈𝑚𝑖𝑛 rovno 0,7. Maximální rozdíl amplitud
napětí dU nastavíme na 0,02 jmenovitého napětí, maximální fázový posun napětí
dphase na 5° a rozdíl frekvencí napětí df na 0,02 Hz jak je znázorněno na Obr. 5.14.

Obr. 5.14: Nastavení limitních hodnot funkce synchro-check

V záložce Control setting nastavíme Energizing mode na Not in use a Operation
mode na Continuous mode. Synchro mode nastavíme na Asynchr. mode. Operate
time představující operační čas synchro-checku nastavíme na hodnotu 0,1 s. Check
time udávající dobu po jakou bude kontrolováno splnění fázovacích podmínek nasta-
víme na hodnotu 0,05 s. Doba trvání spínacího pulsu Close Pulse bude 0,4 s a ope-
rační čas výkonového vypínače Operate time of CB bude 0,1 s. Vyrovnání fázového
posunu napětí Basic Angle ponecháme na 0 a jako Group selection zvolíme Group 1.
Reset register nastavíme na Reset a kombinaci funkcí synchro-check a voltage-check
Voltage combinate na Disable. Zbývající položky Event mask ponecháme, případně
nastavíme, na hodnotách 255. Výsledný pohled na nastavené hodnoty je znázorněn
na Obr. 5.15.

Hotové nastavení odešleme do terminálu pomocí možnosti Download v řádku
nabídek pod položkou Transfer. Vybereme možnost Current page a potvrdíme OK.
Tento postup provedeme u námi upravovaných záložek, tedy u záložky Setting
group1 a Control setting. Okno Download je znázorněno na Obr. 5.16.
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Obr. 5.15: Nastavení funkce synchro-check

Obr. 5.16: Odeslání nastavení do terminálu točivého stroje

26



6 NASTAVENÍ MODULU SYNCHRONIZER
Při testování terminálu točivého stroje REM 545 budeme přístrojem CMC 256+
zkoumat pouze napětí simulované sítě a alternátoru. Proto jako první krok prove-
deme vypnutí proudových výstupů, aby nedošlo k nechtěnému poškození přístroje.

Z řádku nabídek vybereme sekci Parametry a v ní položku Konfigurace hard-
waru. V záložce Obecné klikneme v poli Sada(y) testu na tlačítko Podrobnosti kde
nastavíme Výstupy proudu na <nepoužito> jak vidíme na Obr. 6.1 a potvrdíme
tlačítkem OK.

Obr. 6.1: Nastavení proudových výstupů

Záložku Analogové výstupy nastavíme podle Obr. 6.2 a potvrdíme tlačítkem OK.

Obr. 6.2: Nastavení výstupů napětí pro test
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Tab. 6.1: Informace o terminálu točivého stroje

Nastavení zařízení
Název / popis Terminál točivého stroje
Výrobce ABB
Typ zařízení REM 545
Výrobní číslo 339056
Počet fází 3
𝑓𝑛𝑜𝑚 50
𝑉𝑛𝑜𝑚 (sekundární) 100,000 V (L-L)

Nyní nastavíme velikost Synchronizačního okna, vlastnosti sítě a alternátoru
a zadáme modulu Synchronizer data o terminálu REM 545.

Z řádku nabídek vybereme opět sekci Parametry a v ní položku Objekt testu.
V nově otevřeném okně vybereme možnost Zařízení, které otevře okno Nastavení
zařízení sloužící pro vložení dat o terminálu vývodového pole jak je znázorněno na
Obr. 6.3. Nastavení vyplníme dle Tab. 6.1 a potvrdíme tlačítkem OK.

Obr. 6.3: Vložení informací o terminálu točivého stroje
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V okně Objekt testu otevřeme položku Synchronizer, které nám otevře okno pro
nastavení vlastností sítě a alternátoru jak je znázorněno na Obr. 6.4. Pro oba systémy
nastavíme Připojená napětí na L1-L2 a v poli Nastavení u položky Spustit/Uvolnit:
vybereme možnost Souvislý.

Obr. 6.4: Výběr použitých napětí pro test

Záložku Synchrnozizace okna (Obr. 6.5) vyplníme dle Tab. 6.2.
Výsledné synchronizační okno pak bude vypadat jako na Obr. 6.6.
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Obr. 6.5: Prostředí pro nastavení synchronizačního okna

Tab. 6.2: Hodnoty pro nastavení synchronizačního okna

Synchronizace okna
|Δ fmax| 0.00 mHz
|Δ fmin| 0.00 mHz
Δ f< -190.0 mHz
Δ f> 190.0 mHz
Δ Phi 5.00 °
Δ V> 2.000 V
Δ V< -140.0 mV
Tolerance Phi - absolutní 0.00 °
Tolerance Phi - relativní 0.000 %
Tolerance f - absolutní 10.00 mHz
Tolerance f - relativní 5.263 %
Tolerance V - absolutní 20.00 mV
Tolerance V - relativní 1.000 %
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Obr. 6.6: Synchronizační okno
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7 OVĚŘENÍ FUNKČNOSTI
Po vytvoření konfigurace a nastavení testovacího přístroje bylo provedeno otestování
funkčnosti testerem Omicron 256+. Následně byla provedena příprava k otestování
synchronizace laboratorního alternátoru s laboratorní sítí.

7.1 Test pomocí zkušebního přístroje
Terminál REM 545 byl propojen s testerem Omicron 256+ podle schématu na 7.1.
Na svorkovnici X1.1 terminálu byla přivedena obě napětí. Napětí reprezentující síť,
v testeru značené jako System 1, bylo přivedeno na kontakty 10 a 12. Napětí re-
prezentující alternátor, v testeru jako System 2, pak bylo přivedeno na kontakty 13
a 15. Binární signál informující o splnění synchronizace je vyslán, skrze kontakty 3
a 4 na svorkovnici X5.2 terminálu, zpět do testeru na svorky binárního vstupu 5.

Obr. 7.1: Schéma zapojení pro otestovaní konfigurace testerem ochran

Pro vyzkoušení funkčnosti byl vybrán Test Funkčnosti popsaný v 4.1.1. Bylo
nastaveno celkem 76 testovaných bodů. Pro test byla nastavena maximální doba, po
kterou má být synchronizace kontrolována, na 60 s. Tento čas byl zvolen s ohledem
na některé testované body, které se nacházely v oblasti s nejasným výsledkem.

Po dokončení testu, byl vystaven záznam o zkoušce, který je součástí programu
Synchronizer. Na 7.2 je znázorněn výřez tabulky nastavených hodnot a lokálních
výsledků a také pohled na výsledné zobrazení synchronizačního okna s otestovanými
body. Kompletní záznam o zkoušce je součástí přílohy.

32



Obr. 7.2: Náhled na výsledek testu
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Testované body jsou zapsány do dvou tabulek. První tabulka udává nastavené
odchylky od jmenovitých hodnot, druhá pak absolutní hodnoty. Obě tabulky jsou
vertikálně rozděleny na tři části. První obsahuje nastavený bod. Druhá část udává
na prvním řádku hodnoty při vydání signálu k synchronizaci a na druhém jsou hod-
noty při samotné synchronizaci. Ty jsou, jak je vidět ze čtvrtého sloupce, zpožděny
o 100 ms, tedy o pracovní čas vypínače. Třetí částí tabulky je předpoklad reakce
vypínače, skutečná reakce vypínače a výsledek testu.

Synchronizační okno s výsledkem testu slouží jako rychlý přehled průběhu testu.
V tomto případě se všechny body zachovaly podle předpokladu a jsou tedy zobra-
zeny jako +. Celý test je tedy považován za úspěšný. Pokud by se jeden nebo více
bodů neshodovalo s předpokladem, byly by označeny jako × a tím by byl celý test
považován za neúspěšný.

7.2 Příprava na test reálného provozu
Po úspěšném testu se simulovanými napětími byla provedena příprava pro testování
za pomoci laboratorního zdroje. Tím byl 4 pólový alternátor PARTNER LSA 37
M5 firmy Leroy-Somer.

Byly objednány dva transformátory 400/100 V, které budou sloužit jako měřící
transformátory pro terminál točivého stroje. Jeho napěťové vstupy jsou od výroby
omezeny na napětí 100 V až 120 V mezi fázemi. Laboratorní zdroj i síť mají mezi
fázemi 400 V.

Rozváděč, plánovaný pro použití při testu reálného provozu, umožňuje ruční
synchronizaci. Aby byla tato funkce zachována, je výstupní signál, dávající pokyn
k sepnutí, připojen paralelně k ručnímu ovládání. Návrh zjednodušeného schématu
zapojení je znázorněn na 7.3.

Pomocí ovládacích prvků na dveřích rozváděče se budou opatrně zvyšovat para-
metry alternátoru. Jelikož je funkce Synchro-check nastavena na Continuous mode,
je synchronizace kontrolována nepřetržitě, bez nutnosti vyslat počáteční povel k syn-
chronizaci. Proto jakmile na alternátoru bude dosaženo parametrů, které splňují
nastavené synchronizační podmínky, bude vyslán signál k sepnutí.
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Obr. 7.3: Zjednodušené schéma zapojení pro test na laboratorním zdroji
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8 ZÁVĚR
V první kapitole proběhlo seznámení se základními principy fázování zdrojů energie
do napájecích soustav. Byly uvedeny podmínky, které je nutné dodržet při fázování
aby nedocházelo k nechtěným doprovodným jevům fázování jakými jsou proudové
a momentové rázy. Taktéž byly ujasněny maximální odchylky od jmenovitých hod-
not napětí, frekvence a fázového posunu, jejichž překročení by tyto nechtěné jevy
vyvolalo. Dále byly popsány postupy, které lze při fázování využít, převážně samo-
činné fázovací automaty.

Popsán byl terminál točivého stroje REM 545 firmy ABB, který lze jako samo-
činný fázovací automat využít. Jeho využití je zajištěno funkcí synchro-check.

Pro kontrolu funkčnosti této funkce v laboratorních podmínkách, bez nutnosti
reálné sítě a generátoru, slouží zkušební přístroj CMC 256+ firmy Omicron. V tomto
přístroji je k této funkci připraven specializovaný program Synchronizer, který slouží
právě k testování správné funkčnosti samočinných fázovacích automatů.

Byla vytvořena konfigurace pomocí programu CAP 505 a provedeno nastavení
programu Synchronizer. Postup je popsán v kapitolách 5 a 6. Pro přehlednost jsou
oba postupy popsány samostatně jako součást přílohy. Dále bylo provedeno ověření
funkčnosti pomocí několika testovaných bodů a výsledek byl zaznamenán formou
testové zprávy. Test proběhl úspěšně a reakce vypínače se u všech zvolených bodů
shodovala s předpokladem. Kompletní zpráva je součástí přílohy. Na závěr byla pro-
vedena příprava pro test reálného provozu za pomoci přístrojů dostupných v labo-
ratoři.

Funkce byla, z nedostatku zkušeností s těmito přístroji, vytvořena nejjednoduš-
ším možným způsobem. Její používání si tedy žádá zvýšenou opatrnost při mani-
pulaci s parametry laboratorního soustrojí. Z nově nabytými znalostmi, získanými
vypracováním této práce a dalším studiem dostupných materiálů, by byla funkce
vytvořena jinak. Využity by byly možnosti automatického upravování parametrů
generátoru, pomocí řídících signálů z terminálu točivého stroje. Taktéž by byly při-
dány různé ochranné funkce pro zvýšení bezpečnosti.
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SEZNAM SYMBOLŮ, VELIČIN A ZKRATEK
CB výkonový vypínač – Circiut Breaker

COM rozhraní sériového portu

FBD grafický jazyk pro tvorbu programů – Function Block Diagram

𝑓𝑛𝑜𝑚 nominální hodnota frekvence

f< povel ke snížení kmitočtu

f> povel ke zvýšení kmitočtu

Im imaginární osa

𝑖̄𝑜" fázor rázového proudu

Re reálná osa

SPA odesílatel protokolové adresy – Sender Protocol Address

𝑈̄ fázor napětí generátoru

𝑈̄𝑠 fázor napětí sítě

𝑉𝑛𝑜𝑚 nominální hodnota napětí

V< povel ke snížení napětí

V> povel ke zvýšení napětí

+ vyobrazení úspěšného testu

× vyobrazení neúspěšného testu
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B MANUÁL PRO VYTVOŘENÍ FUNKCE A TES-
TOVÁNÍ

Vytvoření funkce synchro-check pomocí programu CAP 505. Program byl nainsta-
lován v anglickém jazyce, proto následující kroky budou též vypsány anglicky.

1. Spustit CAP 505
2. Relay Configuration Tool - heslo "abb"
3. Označit Logical POUs

• Edit > Insert
• Name: PROTECT
• Type: Program
• Language: FBD

4. Označit Tasks
• Edit > Insert
• Name: T10
• Task type: CYCLYC
• Settings > Interval: 10.0000 ms

5. Označit T10
• Edit > Insert
• Type: Program
• Program instance: PROTECT
• Program type: PROTECT

6. Ozančit REM 545
• File > Edit Object Properties
• Analog Channels
• Channel 5 > Voltage trasformer 1 > Signal Type: U12
• Channel 5 > Measurements > Frequency Protection
• Channel 6 > Voltage trasformer 2 > Signal Type: U12b
• Channel 6 > Measurements > Frequency Protection

7. Otevřít PROTECT
• Add Function Block > SCVCSt1
• Add Variable > U12 (připojit na U1 bloku SCVCSt1)
• Add Variable > U12b (připojit na Uě bloku SCVCSt1)
• Add Variable > BIO_5_SO1 (připojit na SC_OK bloku SCVCSt1)
• Kompilovat list (viz. 5.10)

8. Kompilovat vše (viz. 5.10)
9. Zavřít Relay Configuration Tool
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10. Otevřít Relay Download Tool
• Záložka Send
• Zaškrtnout Relay Configuration a RCT Project
• Zaškrtnout Store + Reset
• Stisknout Send

11. Otevřít Relay Settings Tool
12. Záložka Protection > Záložka SVCVSt1
13. Záložka Setting group1

• Umax: 1 xUn
• Umin: 0,7 xUn
• dU: 0,02 xUn
• dphase: 5 °
• df: 0,02 Hz
• Transfer > Download > Current page

14. Záložka Control setting
• Energizing mode: Not in use
• Operation mode: Continuous mode
• Synchro mode: Asynchr. mode
• Operate time: 0,1 s
• Check time: 0,05 s
• Close pulse: 0,4 s
• Oper. time of CB: 0,1 s
• Basic angle: 0 °
• Group selection: Group 1
• Reset registers: Reset
• Voltage combine: Disabled
• Event mask 1-4: 255
• Transfer > Download > Current page

Nastavení programu Synchronizer pro otestování funkce synchro-check.
1. Spustit Omicron Test Universe > Modul Synchronizer
2. Parametry > Konfigurace Hardwaru
3. Záložka Obecné > Podrobnosti > Výstupy proudu: <nepoužito>
4. Záložka Analogové vstupy

• S1 V L1-L2
• S2 V L1-L2

5. Parametry > Objekt testu > Zařízení (Data zde zadaná jsou určena pro popis
zařízení v rámci výsledné zprávy o testu)

• Název/popis: Terminál točivého stroje

49



• Výrobce: ABB
• Zařízení: REM 545
• Výrobní číslo: 339056

(Všechna ostatní data zůstávají beze změny)
6. Parametry > Objekt testu > Synchronizer
7. Záložka Ochranné zařízení

• Směr otáčení: L1-L2-L3 (pro oba systémy)
• Připojená napětí: L1-L2 (pro oba systémy)
• Spustit/uvolnit: Souvislý

8. Záložka Synchronizace okna
• |Δ fmax|: 0.00 mHz
• |Δ fmin|: 0.00 mHz
• Δ f<: -190.0 mHz
• Δ f>: 190.0 mHz
• Δ Phi: 5.00 °
• Δ V>: 2.000 V
• Δ V<: -140.0 mV
• Tolerance Phi - absolutní: 0.00 °
• Tolerance Phi - relativní: 0.000 %
• Tolerance f - absolutní: 10.00 mHz
• Tolerance f - relativní: 5.263 %
• Tolerance V - absolutní: 20.00 mV
• Tolerance V - relativní: 1.000 %

9. Záložka Nastavení na úvodní obrazovce > Max. synchro: 60 s

Po nastavení všech parametrů a informací následuje výběr testovaných bodů. Bude
proveden jednoduchý test ověření funkce.

1. Záložka Funkce
2. Systém 1: Ponechat beze změny (Systém 1 simuluje parametry sítě)
3. Systém 2: Nastavit bod/y pomocí absolutních hodnot nebo odchylek od Sys-

tému 1 > Přidat
4. Spustit test

Tvorba protokolu o výsledku testu je součástí modulu Synchronizer.
1. Test > Test report
2. Soubor > Tisk
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C OBSAH PŘILOŽENÉHO CD
Přiložené CD obsahuje dokumenty a soubory vycházející z této práce.

Ve složce PDF je vložen dokument s výsledkem testu konfigurace, který byl
proveden pomocí testeru ochran Omicron 256+. Dále je zde vložena elektronická
verze této práce.

Složka CMC 256+ obsahuje soubor programu Synchronizer s nastavením syn-
chronizačního okna a testovanými soubory.

Konfigurace funkce synchro-check vytvořená programem CAP 505 je vložena do
složky CAP. Konfigurace je formou projektu. Celá složka projektu "CEKL" přijde
nahrát do adresáře programu CAP 505, standardně C:\CAP 505\PRJ. Poté stačí
projekt otevřít v programu CAP 505 a uložit do terminálu točivého stroje jak je
popsáno v 5.1.
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